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Getting Started  

Understanding the Basics  

In this lesson, you learn what Autodesk Revit Architecture is and how its parametric change engine benefits you and 
your work. You begin with the fundamental concepts on which Revit Architecture is built. You learn the terminology, 
the hierarchy of elements, and how to perform some common tasks in the product.  

Understanding the Concepts  

What is Autodesk Revit Architecture 2010?  

The Revit Architecture platform for building information modelling is a design and documentation 
system that supports the design, drawings, and schedules required for a building project. Building 
information modelling (BIM) delivers information about project design, scope, quantities, and phases 
when you need it.  

In the Revit Architecture model, every drawing sheet, 2D and 3D view, and schedule is a presentation of 
information from the same underlying building model database. As you work in drawing and schedule 
views, Revit Architecture collects information about the building project and coordinates this information 
across all other representations of the project. The Revit Architecture parametric change engine 
automatically coordinates changes made anywhere—in model views, drawing sheets, schedules, sections, 
and plans.  

What is meant by parametric?  

The term parametric refers to the relationships among all elements of the model that enable the 
coordination and change management that Revit Architecture provides. These relationships are created 
either automatically by the software or by you as you work. In mathematics and mechanical CAD, the 
numbers or characteristics that define these kinds of relationships are called parameters; hence, the 
operation of the software is parametric. This capability delivers the fundamental coordination and 
productivity benefits of Revit Architecture: Change anything at any time anywhere in the project, and 
Revit Architecture coordinates that change through the entire project.  

The following are examples of these element relationships:  

 The outside of a door frame is a fixed dimension on the hinge side from a perpendicular partition. 
If you move the partition, the door retains this relationship to the partition.  

 Windows or pilasters are spaced equally across a given elevation. If the length of the elevation is 
changed, the relationship of equal spacing is maintained. In this case, the parameter is not a 
number but a proportional characteristic.  

 The edge of a floor or roof is related to the exterior wall such that when the exterior wall is 
moved, the floor or roof remains connected. In this case, the parameter is one of association or 
connection.  

How does Autodesk Revit Architecture 2010 keep things updated?  

A fundamental characteristic of a building information modelling application is the ability to coordinate 
changes and maintain consistency at all times. You do not have to intervene to update drawings or links. 
When you change something, Revit Architecture immediately determines what is affected by the change 
and reflects that change to any affected elements.  
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Revit Architecture uses 2 key concepts that make it especially powerful and easy to use. The first is the 
capturing of relationships while the designer works. The second is its approach to propagating building 
changes. The result of these concepts is software that works like you do, without requiring entry of data 
that is unimportant to your design.  

Element behavior in a parametric modeler  

In projects, Revit Architecture uses 3 types of elements:  

 Model elements represent the actual 3D geometry of the building. They display in relevant views 
of the model. For example, walls, windows, doors, and roofs are model elements.  

 Datum elements help to define project context. For example, grids, levels, and reference planes 
are datum elements.  

 View-specific elements display only in the views in which they are placed. They help to describe 
or document the model. For example, dimensions, tags, and 2D detail components are view-
specific elements.  

 

There are 2 types of model elements:  

 Hosts (or host elements) are generally built in place at the construction site. For example, walls 
and roofs are hosts.  

 Model components are all the other types of elements in the building model. For example, 
windows, doors, and cabinets are model components. 

There are 2 types of view-specific elements:  

 Annotation elements are 2D components that document the model and maintain scale on paper. 
For example, dimensions, tags, and keynotes are annotation elements.  

 Details are 2D items that provide details about the building model in a particular view. Examples 
include detail lines, filled regions, and 2D detail components.  

This implementation provides flexibility for designers. Revit Architecture elements are designed to be 
created and modified by you directly; programming is not required. If you can draw, you can define new 
parametric elements in Revit Architecture.  
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In Revit Architecture, the elements determine their behavior largely from their context in the building. 
The context is determined by how you draw the component and the constraint relationships that are 
established with other components. Often, you do nothing to establish these relationships; they are 
implied by what you do and how you draw. In other cases, you can explicitly control them, by locking a 
dimension or aligning 2 walls, for example.  

Understanding Autodesk Revit Architecture 2010 terms  

Most of the terms used to identify objects in Revit Architecture are common, industry-standard terms 
familiar to most architects. However, some terms are unique to Revit Architecture. Understanding the 
following terms is crucial to understanding the software.  

Project: In Revit Architecture, the project is the single database of information for your design—the 
building information model. The project file contains all information for the building design, from 
geometry to construction data. This information includes components used to design the model, views of 
the project, and drawings of the design. By using a single project file, Revit Architecture makes it easy 
for you to alter the design and have changes reflected in all associated areas (plan views, elevation views, 
section views, schedules, and so forth). Having only one file to track also makes it easier to manage the 
project.  

Level: Levels are infinite horizontal planes that act as a reference for level-hosted elements, such as roofs, 
floors, and ceilings. Most often, you use levels to define a vertical height or story within a building. You 
create a level for each known story or other needed reference of the building; for example, first floor, top 
of wall, or bottom of foundation. To place levels, you must be in a section or elevation view.  

 

Level 2 work plane cutting through the 3D view with the corresponding floor plan next to it  

 

Element: When creating a project, you add Revit Architecture parametric building elements to the design. 
Revit Architecture classifies elements by categories, families, and types.  

Category: A category is a group of elements that you use to model or document a building design. For 
example, categories of model elements include walls and beams. Categories of annotation elements 
include tags and text notes.  

Family: Families are classes of elements in a category. A family groups elements with a common set of 
parameters (properties), identical use, and similar graphical representation. Different elements in a family 
may have different values for some or all properties, but the set of properties—their names and 
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meaning—is the same. For example, 6-panel colonial doors could be considered one family, although the 
doors that compose the family come in different sizes and materials.  

 

There are 3 kinds of families:  

 Loadable families can be loaded into a project and created from family templates. You can 
determine the set of properties and the graphical representation of the family.  

 System families include walls, dimensions, ceilings, roofs, floors, and levels. They are not 
available for loading or creating as separate files.  

 Revit Architecture predefines the set of properties and the graphical representation of 
system families.  

 You can use the predefined types to generate new types that belong to this family within 
the project. For example, the behavior of a wall is predefined in the system. However, 
you can create different types of walls with different compositions.  

 System families can be transferred between projects.  

 In-place families are custom families that you create in the context of a project. Create an in-
place family when your project needs unique geometry that you do not expect to reuse or 
geometry that must maintain one of more relationships to other project geometry.  

 Because in-place families are intended for limited use in a project, each in-place family 
contains only a single type. You can create multiple in-place families in your projects, 
and you can place copies of the same in-place family element in your projects. Unlike 
system and standard component families, you cannot duplicate in-place family types to 
create multiple types.  

Type: Each family can have several types. A type can be a specific size of a family, such as a 30” X 42” 
title block or a 32" x 84" door. A type can also be a style, such as default aligned or default angular style 
for dimensions.  

Instance: Instances are the actual items (individual elements) that are placed in the project and have 
specific locations in the building (model instances) or on a drawing sheet (annotation instances).  

Understanding the Revit Architecture User Interface 

Revit Architecture is a powerful CAD product for the Microsoft® Windows operating system. Its 
interface resembles those of other products for Windows featuring a ribbon that contains the tools used to 
complete tasks.  
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In the Revit Architecture interface, many of the components (such as walls, beams, and columns) are 
available at the click of a button. You can place these components in the drawing and immediately 
determine whether they meet your design requirements.  

The Revit Architecture interface is designed to simplify your workflow. With a few clicks, you can 
change the interface to better support the way that you work. For example, you can set the ribbon to one 
of the three display settings for optimum use of the interface. You can also display several project views 
at one time, or layer the views to see only the one on top.  

  

Hints 
Project Browser:  Select Views label at top of Project Browser window and right click to access 

Properties to change View Filters. 
 
Options Bar:  The features shown in this area are tool dependent. See the Wall Tool example 

below. 
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Home Ribbon 

 

 

Insert Ribbon 

 

 

Annotate Ribbon 

 

 

Modify Ribbon 

 

 

Massing & Site Ribbon 

 

 

Collaborate Ribbon 
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View Ribbon 

 

 

Manage Ribbon 

 

 

Add-Ins Ribbon 

 

 

The View Cube 

You can click and drag the ViewCube to reorient the view of a model to a custom viewpoint or click on 
one of the twenty-six predefined viewpoints that are available. As you drag, the mouse pointer changes to 
indicate that you are reorienting the current view of the model. If you drag the ViewCube close to one of 
the preset orientations and it is set to snap to the closest view, the ViewCube rotates to the closest preset 
orientation. 

 

 

 

 

The Steering Wheel 

Pressing and dragging on a wedge of a wheel is the primary mode of interaction. After a wheel is 
displayed, click one of the wedges and hold down the button on the pointing device to activate the 
navigation tool. Drag to reorient the current view. Releasing the button returns you to the wheel. 

 
 

 

 



Getting Started | 10 

Navigation Bar 

You can control which navigation tools are displayed on the navigation bar with the Customize menu. 
The Customize menu is displayed by clicking the Customize button. From the Customize menu, you click 
the navigation tools that you want displayed on the navigation bar. The position of the navigation tools on 
the navigation bar is predefined and cannot be changed. 

 
 

 

 

 

Creating a Project  
In this first exercise, you create and name a project in which you will create the building model shown.  

 

1 Create a project:  

 Click   New  Project.  

 In the New Project dialog box, under Create New, verify that Project is selected.  

 Under Template file, verify the second option is selected, and click Browse.  

 Verify C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2010\Imperial 
Templates\default.rte [DefaultMetric.rte] is selected, and click Open.  

 In the New Project dialog box, click OK.  

2 Name and save the project file:  

 Click   Save.  
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 In the left pane of the Save As dialog box, click Training Files, and then, in the file window, 
double-click Imperial [Metric].  

 For File name, enter Getting Started, and click Save.  

3 Zoom to a view:  

 In the Project Browser, double-click Elevations (Building Elevation)  South.  

 Enter ZR, to zoom to a specific region. Note that the cursor changes to a magnifying glass.  

 In the drawing area, move the cursor diagonally and click to draw a rectangle around the 
level markers. The area within the rectangle is magnified to fill the drawing area so that you 
can work with the level marker text.  

 

4 Rename levels:  

 Double-click the Level 1 text, enter 00 Foundation, and press Enter. Use a number as a prefix 
to the name so the plans are sorted by level.  

 In the Alert dialog box, click Yes to rename corresponding views. The floor and ceiling plans 
for Level 1 are renamed 00 Foundation. 

 

 Using the same method, rename Level 2 and its corresponding views as 01 Lower Level.  

5 Create levels in the building:  

 Enter ZO to zoom out.  

 Click Home tab  Datum panel  Level.  
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 On the Draw panel, click  (Pick Lines).  

 On the Options Bar enter 10' [3000 mm] for the Offset. 

 In the drawing area, highlight the 01 Lower Level line; when a dashed line is displayed above 
the level line, click to create a level (Level 3).  

 Using the same method, create a level above Level 3.  

6 On the Panel Level tab, click Modify to end the command.  

7 Rename the new levels and all corresponding views:  

 Level 3: Rename as 02 Entry Level  

 Level 4: Rename as 03 Roof  

8 Double-click the level dimensions, and enter new values:  

 0' 0'' [0 mm]: Change to -14' 0'' [-5250 mm]  

 10' 0'' [4000 mm]: Change to -10' 0'' [-3050 mm]  

 20' 0'' [7000 mm]: Change to 0' 0'' [0 mm]  

 30' 0'' [10000 mm]: Change to 10' 0'' [3050 mm]  

9 Press Esc twice to deselect and exit command.  

10 Save the project file.  

Creating Walls  

In this exercise, you work on different levels to add foundation walls to the project.  

 

1 In the Project Browser, under Floor Plans, double-click 00 Foundation to open that view in the 
drawing area.  

2 Click Home tab  Build panel  Wall.  

3 Click Place Wall tab  Element panel  Change Element Type drop-down and select Basic Wall: 
Retaining - 12'' Concrete [Basic Wall : Retaining - 300mm Concrete].  

4 On the Options Bar:  
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 For Height, select 02 Entry Level.  

 For Location Line, verify that Wall Centerline is selected.  

 Verify that Chain is selected.  

5 In the drawing area, draw walls on the foundation level:  

 Click in the lower-right quadrant to select the wall start point.  

 Move the cursor to the left, enter 40' [12000 mm], and press Enter.  

NOTE: You do not need to specify the unit; Autodesk® Revit® Architecture software uses the 
units specified in the project template.  

 Beginning at the new endpoint, move the cursor up, enter 22' [6900 mm], and press Enter.  

 Move the cursor to the right, enter 40' [12000 mm], and press Enter.  

6 On the Place Wall tab, click Modify to exit the command.  

7 In the Project Browser, under Floor Plans, double-click 01 Lower Level.  

8 Click Home tab  Build panel  Wall.  

9 Click Place Wall tab  Element panel  Change Element Type drop-down and select Basic Wall: 
Foundation - 12'' Concrete [Basic Wall : Foundation - 300mm Concrete].  

10 On the Options Bar, for Depth, select 00 Foundation and for Location Line, verify that Wall 
Centerline is selected.  

11 Draw walls on the lower level:  

 In the drawing area, click the right endpoint of the south wall as the wall start point.  

 Move the cursor to the right, enter 6' 6'' [1950 mm], and press Enter.  

 Move the cursor up, enter 5' [1500 mm], and press Enter.  

 Move the cursor to the right, enter 10' 6'' [3150 mm], and press Enter.  

 Move the cursor up, and select the intersection with the extension of the north wall. 

 

 Select the right endpoint of the north wall to complete the chain and connect the walls.  

12 On the Place Wall panel, click Modify.  
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13 Save the project file. 

Creating Terrain  

In this exercise, you create a 3D view and add a toposurface to the building site.  

 

1 In the Project Browser, under Floor Plans, double-click 02 Entry Level.  

2 Create a 3D view:  

 Click the View tab ➤ Create panel ➤3D View drop-down ➤ Camera.  

 Click in the upper-right corner of the drawing area to place the camera.  

 Click to place the camera target point, as shown.  

 

A 3D view is created. The view you create may differ slightly from the illustrations shown in 
the exercises because of minor variations in camera placement. Drag the blue circular 
controls that display on the crop region of the resulting view so that you can see the building.  

3 In the Project Browser, expand 3D Views, right-click 3D View 1, and click Rename.  

4 In the Rename View dialog box, enter To Building, and click OK.  
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5 Create a graded building site:  

 In the Project Browser, under Floor Plans, double-click Site.  

 Click Massing & Site tab  Model Site panel  Toposurface.  

 On the Options Bar, for Elevation, enter -0' 6'' [-150 mm].  

 Add points to the left of the building, as shown. The order of the point selection is not 
important.  

 

 On the Options Bar, for Elevation, enter -10' [-4000 mm].  

 Add points near the center of the building, as shown. Contour lines are displayed.  
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 On the Options Bar, for Elevation, enter -11' [-4300 mm].  

 Add points to the right of the building, as shown. 

        

 Click Edit Surface tab  Surface panel  Finish Surface.  

6 Create a pad surface:  

 Click Massing & Site tab  Model Site panel  Building Pad.  

 On the Draw panel, click  (Rectangle). 

 Select the outer endpoint at the lower left of the building, as shown.  

 Select the outer endpoint at the upper right of the building.  

 On the On the Create Pad Boundary tab, in the Building Pad panel, click Finish Building Pad.  

 

7 Open the To Building 3D view to see the results.  

8 Save the project file. In this exercise, you created a simple toposurface in Autodesk Revit 
Architecture by selecting points. However, for most projects, complex site models created by civil 
engineering professionals will be provided to you in DWG, DXF, DGN, or point files. You can 
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import these files into your Revit Architecture project where you can automatically generate a 
terrain using the Toposurface tool.  

Adding Exterior Walls  

In this exercise, you build upon the foundation walls. You use the Draw option to create exterior walls 
that extend to the roof level.  

 

1 Add walls to the entry level:  

 In the Project Browser, under Floor Plans, double-click 02 Entry Level.  

 Click Home tab Build panel  Wall. 

 Click Place Wall tab  Element panel  Change Element Type drop-down and select Basic 
Wall : Generic - 6'' [Basic Wall : Generic - 200mm].  

 On the Options Bar: for Height, select 03 Roof, and for Location Line, select Core Face: 
Interior. The Height setting defines how tall the wall is and establishes a relationship between 
the walls and the roof. After you draw the walls, if you change the roof height, the height of 
the walls will also change.  

 Beginning at the bottom right, trace the interior of the three existing retaining walls by 
selecting endpoints.  

 On the Place Wall tab, click Modify.  

2 Add walls to the lower level:  

 Open the 01 Lower Level floor plan. Notice that the foundation walls are now visible at the 
right of the plan, so that you can trace them.  

 Click Home tab  Build panel  Wall  Element panel  Change Element Type drop-down 
and select Basic Wall : Generic - 6'' [Basic Wall : Generic - 200mm]. 

 On the Options Bar, for Height, select 03 Roof.  
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 Beginning at the left endpoint of the north foundation wall, trace the interior of the 
foundation walls by selecting endpoints.  

 On the Place Wall tab, click Modify.  

3 Open the To Building 3D view.  

4 Save the project file.  

Adding a Roof  

In this exercise, you create a roof using the footprint of the exterior walls. You specify an offset as you 
create the roof so that the roof has an overhang.  

 

1 Open the 03 Roof floor plan.  

2 Draw a roof line:  

 Click Home tab  Roof drop-down ➤ Roof by Footprint. 

 On the Draw panel, click  (Line).  

 On the Options Bar, verify that Defines slope is selected.  

 To draw the first roof segment, begin at the bottom left and trace the exterior edge of the 
south wall by selecting the left wall endpoint and the intersection of the south and far-east 
wall.  
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3 Create offset roof lines:  

 On the Draw panel, verify  (Pick Walls) is selected. 

 On the Options Bar, for Offset, enter 3' [900 mm], and clear Defines slope.  

 In the drawing area, highlight the west wall; when a dashed line is displayed on the exterior 
of the wall, click to place the roof line. Repeat for the north and east walls.  

4 Use the Trim/Extend tool to close the roof sketch:  

 On the Edit panel, click  (Trim).   

 Select the east roof line, and then select the south roof line. Repeat for the west and south 
roof lines.  

 

 On the Create Roof Footprint panel, click Finish Roof. The resulting roof has an odd slope, 
which you correct in the next step. 

  

5 Modify the roof slope:  

 Select the roof.  

 Click Modify Roofs tab  Elements panel  Element Properties. 

 In the Element Properties dialog box, under Dimensions, for Slope, enter 1''/12" [5°], and 
click OK.  

 Click in the Drawing area to deselect the roof. 

6 Open the To Building 3D view. Select and modify the crop region as necessary to see the roof. The 
walls are not attached to the roof; you will attach them in a later exercise.  

7 Save the project file.  
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Adding Floors  

In this exercise, you create floors in the building model.  

To create floors in Autodesk Revit Architecture, you must sketch them first in a sketch editor. You use 
two different sketching options, Pick and Draw, to sketch the floors.  

1 Open the 01 Lower Level floor plan.  

2 Create a floor using the Pick method:  

 Click Home tab  Build panel  Floor.  

 On the Draw panel, click  (Pick Lines).  

 On the Options Bar, verify that Offset is 0. 

 Beginning with the north wall and moving counterclockwise, select the interior of the walls. 

 On the Create Floor Boundary tab, click Modify. 

3 Enter ZR, and zoom in to the top-right corner of the model. If the floor lines do not create a closed 
sketch, the sketch is invalid and you need to clean the lines up. To be valid, the sketch must be a 
closed loop with no disconnected or crossing lines.  

 

4 Create a closed sketch:  

 On the Create Floor Boundary tab, click  (Trim).  

 Trim as necessary, selecting the portion of each line you want to retain.  

 

 Enter ZP to zoom to the previous display.  

 Click Create Floor Boundary tab  Floor panel  Finish Floor.  
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5 In the Alert dialog box, click No.  

If you clicked Yes, the walls that finish on the lower level would be trimmed to the underside of the 
floor.  

6 Create a floor using the Draw method:  

 Open the 02 Entry Level floor plan.  

 Click Home tab Build panel  Floor.  

 On the Draw panel, click  (Line).  

 On the Options Bar, verify that Chain is selected.  

 Beginning at the lower-left interior corner, select the lower endpoint of the west wall, and 
then select the upper endpoint.  

 Move the cursor to the right 36' [10000 mm], and click to draw the sketch line.  

 Move the cursor down 16' 6'' [5300 mm] to align with the outside of the wall, and click to 
specify the point.  

 Move the cursor to the right 25' [9000 mm], and click.  

 Move the cursor down 4' 6' [1300 mm] to align with the inside of the wall, and click.  

 Move the cursor to the left, enter SZ to find the loop endpoint, and select the endpoint to 
complete the floor sketch.  

 Click Create Floor Boundary tab  Floor panel  Finish Floor.  

 

7 In the Alert dialog box, click No.  

8 View the floors in 3D:  

 Open the To Building 3D view.  

 Select the wall as shown.  
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 On the View Control Bar, click Temporary Hide/Isolate  Hide Element. The selected wall 
is temporarily hidden so that you can see the interior floors.  

 On the View Control Bar, click Model Graphics Style  Shading with Edges.  

 On the View Control Bar, click Temporary Hide/Isolate  Reset Temporary Hide/Isolate.  

9 Save the project file.  

Adding Interior Walls  

In this exercise, you add walls on the lower level and the entry level, and then modify the walls to create 
rooms in the building.  

 

1 Open the 01 Lower Level floor plan.  

2 Click Home tab  Build panel  Wall.  

3 Click Place Wall tab  Element panel  Change Element Type drop-down and select Basic Wall : 
Generic - 6'' [Basic Wall : Generic - 200mm].  

4 On the Options Bar:  

 For Height, select 02 Entry Level.  

 For Location Line, select Wall Centerline.  
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 Clear Chain.  

5 Add walls:  

 Zoom in to the west wall, move the cursor along the north wall centerline, enter 26'        
[8000 mm], and press Enter to specify the wall start point. Move the cursor down, and click 
on the south wall centerline to complete wall 1.  

 On the Place Wall tab, click Modify.  

 Right-click on the wall, and click Create Similar.  

 Using the following illustration as a guide, place additional walls to create rooms.  

 

6 Modify walls to create a corridor:  

 Click Modify tab  Edit panel   (Split). Click on wall 1 in the area indicated by the 
short line in the previous illustration.  

 On the Edit panel, click  (Trim).  

 Trim the split wall to create a corridor, as shown.  

 

7 On the Modify tab, click Modify.  

8 Draw walls:  



Getting Started | 24 

 Open the 02 Entry Level floor plan.  

 Right-click on one of the half-tone walls shown in the underlay of the lower level, and click 
Create Similar.  

 Using the following illustration as a guide, place additional walls to create rooms.  

 

9 On the Modify tab, click Modify. The walls defining the rooms on the lower level and the entry 
level are complete.  

10 Save the project file.  

Adding Doors  

In this exercise, you load doors from the Training Files folder into the project, and then add interior and 
exterior doors to the model.  

1 Click  Home tab  Build panel  Door.  

There are a limited number of door types in the project because there were few in the default 
template. You can load additional door types from the Training Files folder.  

2 Load doors from the Training Files folder:  

 On the Model panel, click Load Family.  

 In the left pane of the Load Family dialog box, click Imperial Library [Metric Library], and 
double-click on the Doors folder.  

 While pressing Ctrl, select the door types: Bifold-4 Panel.rfa, Double-Glass 1.rfa, Single-
Glass 1.rfa [M_Bifold-4 Panel.rfa, M_Double-Glass 1.rfa, M_Single-Glass 1.rfa].  

 Click Open.  

3 Add exterior doors:  

 Open the 01 Lower Level floor plan.  

 Click Home tab  Build panel  Door.  

 On the Options Bar, clear Tag on Placement.  
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 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Double-Glass 1 : 72'' x 84'' [M_Double-Glass 1 : 1830 x 2134mm], add a door to the east 
wall as shown, and then click Modify.  

  

 Open the 02 Entry Level floor plan.  

 Click Home tab  Build panel  Door.  

 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Double-Glass 1 : 72'' x 84'' [M_Double-Glass 1 : 1830 x 2134mm].  

 Place the door in the north wall 7' [2100 mm] from the end of the retaining wall, as shown.  

 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Single-Glass 1 : 36'' x 84'' [M_Single-Glass 1 : 0915 x 2134mm].  

 Place the door in the short vertical wall, as shown.  

 

NOTE: To change the swing direction as you place a door, press the Spacebar. To change the 
swing after a door is placed, click the flip arrows.  

 

4 Add interior doors:  

 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Single-Flush : 32'' x 84'' [M_Single-Flush : 0813 x 2134mm], and add two doors, as shown.  
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 Open the 01 Lower Level floor plan.  

 Click Home tab  Build panel  Door.  

 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Single-Flush : 30'' x 84'' [M_Single-Flush : 0762 x 2134mm], and place two doors, as shown.  

 

 Click Place Door tab  Element panel  Change Element Type drop-down and select 
Bifold-4 Panel : 72'' x 84'' [M_Bifold-4 Panel : 1830 x 2134mm], and place two doors, as 
shown.  

 

5 Open the To Building 3D view.  

6 For an unobstructed view of the doors, select a wall, and on the View Control Bar, click Temporary 
Hide/Isolate  Hide Category. All the walls in the view are hidden.  

7 On the View Control Bar, click Temporary Hide/Isolate  Reset Temporary Hide/Isolate.  

8 Save the project file.  
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Adding Windows  

In this exercise, you work in elevation and plan views to add windows to the model. You use alignment 
and dimension tools to more precisely position the windows.  

1 Add windows in an elevation view:  

 Open the South elevation view, and zoom in to the building.  

 Click Home tab  Build panel  Window.  

 On the Options Bar, clear Tag on Placement.  

 On the Model panel, click Load Family.  

 In the left pane of the Load Family dialog box, click Imperial Library [Metric Library], and 
double-click on the Windows folder to open it. 

 Select Casement 3x3 with Trim.rfa [M_Casement 3x3 with Trim.rfa], and click Open.  

 Add two windows, approximately as shown. You will position them and align them with the 
top of the retaining wall later. If either of the windows spans an internal wall, a warning 
about the conflict is displayed; close the warning. You will resolve any conflict by moving 
the windows while in a floor plan view.  

 

2 Open the 01 Lower Level floor plan. Because the windows are at the top of the wall, they are above 
the current view range for the plan.  

3 Modify the view range:  

 In the drawing area, right-click, and click View Properties.  

 In the Element Properties dialog box, under Extents, for View Range, click Edit.  

 In the View Range dialog box, for Cut plane Offset, enter 7' [2160 mm].  

 Click OK twice. The windows are now visible in the south wall.  

4 If necessary, move the windows to resolve the conflict with the wall:  

 Select the right window, and drag it 2' 6'' [200 mm] to the left side of the interior wall. Select 
the window and edit the temporary dimensions, as needed.  

 Select the left window, and drag it 9' 6'' [2775 mm] to the right of the west wall.  
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5 Create a window type:  

 Open the South elevation view and select the window on the left. 

 Click Element panel  click Element Properties drop-down menu   Type Properties.  

 In the Type Properties dialog box, click Duplicate.  

 In the Name dialog box, for Name, enter 36'' x 36'' [0915 x 0915 mm], and click OK.  

 In the Type Properties dialog box, under Dimensions, for Height, enter 3' [915 mm].  

 Click OK twice.  

6 Modify a window. 

 Select the window on the right. 

 Click Elements Panel  Change Element Type drop-down and select Casement 3x3 with 
Trim : 36'' x 36'' [M_Casement 3x3 with Trim : 0915 x 0915mm].  

7 Align the windows to the top of the retaining wall:  

 Click Modify tab  Edit panel  (Align).  

 Select the top of the wall, and then select the top edge of the trim of one of the windows. Be 
careful to select the top of the wall, and not the 02 Entry Level line.  

 Repeat for the second window.  
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8 Add windows in plan view:  

 Open the 02 Entry Level floor plan, and zoom in to the west side of the model.  

 In the drawing area, right-click, and click View Properties.  

 In the Element Properties dialog box, under Graphics, for Underlay, select None, and click 
OK.  

 Click View tab  Graphics panel  (Thin Lines) so that element lines maintain 
their true thickness in the zoomed view.  

 Click Home tab  Build panel  Window.  

 On the Options Bar, verify that Tag on Placement is cleared.  

 Click Place Window tab  Element panel  Change Element Type drop-down and select 
Casement 3x3 with Trim : 36'' x 72'' [M_Casement 3x3 with Trim : 0915 x 1830mm], and 
place three windows on the outside edge of the west wall, as shown.  

 

 

9 Reposition the windows to be equidistant from each other:  

 Click Annotate tab  Dimension panel  Aligned.  

 Select the north wall, select each of the window centerlines, and then select the horizontal 
interior wall.  
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 Click to the left of the west wall to place the dimension line. Note that each of the four 
dimensions is different. 

  

 Click , and then press Esc twice. The windows are moved so that all of the dimensions 
are equal. 

  

 Select the interior wall that contains the doors; move it up or down to see how the design 
intent is maintained.  

 Select the top wall, move it up 3' [1000 mm], and see how the walls resize and the windows 
redistribute equally within the wall.  

 On the Quick Access toolbar, click  (Undo) once to restore the top wall to the original 
dimension.  

10 Select the dimension line, and press Delete. In the Warning dialog box, click OK to delete the line 
but maintain the constraints.  

11 Zoom as desired, and open various plan, elevation, and 3D views to display the model results thus 
far.  

12 Save the project file.  
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Adding a Curtain Wall  

In this exercise, you change existing exterior walls to curtain walls. You then create a curtain wall type 
that you can apply to other walls using the Match Type tool.  

 

 

1 Open the 01 Lower Level floor plan.  

2 Create a curtain wall at the northeast corner of the building:  

 Zoom to the east wall.  

 Click Modify tab  Edit panel   (Split), and split the east wall just above the door.  

 On the Modify tab, click Modify.  

 While pressing Ctrl, select the upper portion of the east wall and the adjacent portion of the 
north wall.  

 Click Element panel  Change Element Type drop-down and select Curtain Wall : 
Storefront. If a warning displays, click to close it.  
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3 Create a curtain wall type:  

 Select the north curtain wall at an end so the whole curtain wall is selected. The tooltip and 
the status bar will confirm the selection.  

 Click Element panel  click Element Properties drop-down menu  Type Properties.  

 In the Type Properties dialog box, click Duplicate.  

 In the Name dialog box, for Name, enter House 4' x 4' [House 1200 x 1200 mm], and click 
OK.  

 In the Type Properties dialog box, under Vertical Grid Pattern, for Spacing, enter 4'        
[1200 mm].  

 Under Horizontal Grid Pattern, for Spacing, enter 4' [1200 mm].  

 Click OK twice.  

4 Match the type of the north curtain wall to the east curtain wall:  

 Click Modify tab  Clipboard panel   (Match Type).  

 Select the north curtain wall, and then select the east curtain wall.  

5 Open the To Building 3D view. The new spacing is applied to both curtain walls.  

6 Save the project file.  
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Attaching Walls to the Roof  

In this exercise, you attach interior and exterior walls to the roof. When you attach the curtain walls, 
Autodesk Revit Architecture warns you of consequences and modifies the placement of mullions.  

 

1 Open the 03 Roof floor plan. 

 2 Attach the basic walls:  

 While pressing Ctrl, select all the interior walls and exterior walls, except the curtain walls.  

 Click Modify Walls tab  Modify Wall panel  Attach.  

 In the Options Bar, for Attach Wall, verify Top is selected.  

 In the drawing area, select the roof.  

 Press Esc to end the command.  

3 Attach the curtain walls:  

 Open the North elevation view.  

 Move the cursor over the curtain wall, and press Tab until the status bar indicates that the 
curtain wall is selected, select the outside edge of the curtain wall, and then on the Modify 
Walls tab, at the Modify panel, click Attach.  

 Select the roof.  

 In the Error dialog box about curtain wall mullions, click Delete Elements.  

 Open the East elevation view, and attach the east curtain wall to the roof.  

4 Open the To Building 3D view.  

5 On the View Control Bar, click Shadows Off  Shadows On. All walls extend up to the roof. Note 
the spacing of the top row of mullions/panels; because the spacing parameter cannot be satisfied, 
mullions are created where the walls and roof attach.  
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6 Save the project file.  

Modifying the Entry Deck  
In this exercise, you modify the floor profile on the entry level to include a deck on the north side of the 
model.  

 

1 Open the 02 Entry Level floor plan.  

2 Edit the profile of the floor:  

 Select the floor. Hover over the wall and use press Tab two times to select the floor. 

 Click Modify Floors tab  Edit panel  Edit Boundary.  

 On the Draw Panel, click Boundary Line. On the north side of the model, click on the north 
wall in line with the right vertical sketch line, move the cursor up 11' [3300 mm], and click to 
place the endpoint of the line.  

 

 Press Esc to finish this line. 

 On the Options Bar, select Chain.  
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 At the intersection of the double door and the north wall draw a sketch line from the interior 
intersection up 6'' [200 mm] north and then west to the end of the northern wall along the 
exterior side.  

 

 Continue drawing a line from the left endpoint of the north wall and extending up 3' 6''   
[1000 mm].  

 Connect the line with the upper endpoint of the 11' [3000 mm] vertical line drawn previously.  

 

 Click Edit Boundary tab  Edit panel  (Split), and split the north model line at 
both sides of the door opening.  

 

 

 

 On the Edit Boundary tab, click Modify.  

 Select the segment at the door opening, and press Delete.  

 Click Edit Boundary tab  Draw panel  Boundary Line, and complete the profile to the 
right of the door, as shown. Press Esc to exit the command. 

 

 

 On the Floor panel, click Finish Floor.  



Getting Started | 36 

 In the Alert dialog box, click No.  

3 Add a wall to the entry deck:  

 Click Home tab  Build panel  Wall.  

 Click Place Wall tab  Element panel  Change Element Type drop-down and select Basic 
Wall : Retaining - 12'' Concrete [Basic Wall : Retaining 300mm Concrete].  

 On the Options Bar, for Location Line, select Core Face: Interior.  

 Draw a wall from left to right on the slanted floor line, as shown and press Esc to exit the 
command. 

   

 Select the wall previously created.  

 Click Modify Walls tab  Element panel  (Element Properties).  

 In the Element Properties dialog box, under Constraints, for Base Constraint, select              
00 Foundation, and click OK.  

4 Modify the floor: 

 In the drawing area, select the floor.  

 Click Modify Floors tab  Edit panel  Edit Boundary.  

 Select the short vertical line above the west wall, and drag it to the right, as shown.  

 

 Click Modify Floors > Edit Boundary tab  Floor panel  Finish Floor.  

 In the Alert dialog, click No.  

5 Open the To Building 3D view.  

6 Save the project file.  
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Adding a Sloped Floor  

In this exercise, you add a sloped floor to the entry deck to create a ramp up to the entry door.  

1 Open the 02 Entry Level floor plan.  

2 Sketch the floor:  

 Click Home tab  Build panel  Floor.  

 On the Draw panel, click  (Line). 

 On the Options Bar, verify that Chain is selected.  

 Beginning at the left endpoint of the 6'' [200 mm] north wall and moving counterclockwise, 
sketch the floor to complete the deck previously drawn, as shown.  

 

 Click Create Floor Boundary tab  Draw panel   (Slope Arrow). 

  Select the midpoint of the west model line, and then select the east model line.  

 

 On the Create Floor Boundary tab, select Modify. 

 Select the slope arrow.  

 Click Create Floor Boundary tab  Draw panel   (Properties).  

 In the Instance Properties dialog box, under Constraints, for Height Offset at Tail, enter -1'   
[-300 mm], and click OK.  

 On the Floor panel, click Finish Floor.  

 In the Alert dialog box, click No.  

3 Open the North elevation view. The sloped floor begins at the lower level and extends to the entry 
level.  
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4 If the sloped floor does not meet the slope of the terrain, edit the floor sketch, and change the 
Height Offset at Tail property of the slope arrow.  

Adding Stairs and Railings  

In this exercise, you complete the interior of the model by adding a staircase on the lower level, and then 
adding and modifying railings on the lower level and the entry level.  

 

1 Open the 01 Lower Level floor plan.  

2 Add stairs:  

 Zoom in to the east side of the model.  

 Click Home tab  Circulation panel  Stairs.  

 Click near the double doors to start the stair run.  

 Move the cursor to the left until the tooltip indicates that no risers remain, and click to 
specify the stair endpoint. 
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 Click Create Stairs Sketch tab  Stairs panel  Finish Stairs.  

3 Edit the floor profile:  

 Open the 02 Entry Level floor plan.  

 Zoom in to the east side of the model.  

 Select the floor. 

 Click Modify Floors tab  Edit panel  Edit Boundary.  

 On the Draw panel, click  (Line).  

 On the Options Bar, verify that Chain is selected.  

 Click at the corner of the model lines below the stairs to specify the start point.  

 Move the cursor to the left, enter 6' [1800 mm], and press Enter.  

 Move the cursor up, enter 3' 4'' [1100 mm], and press Enter. This distance is the width of the 
stair and its stringers.  

 Move the cursor to the right, and click on the vertical line to complete the sketch.  

 

 On the Modify Floors > Edit Boundary tab, click Modify.  
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 Select the vertical model line closest to the stairs, and drag the bottom endpoint up to the 
endpoint of the short horizontal line drawn previously.  

 

 Click Modify Floors > Edit Boundary tab  Floor panel  Finish Floor.  

 In the Alert dialog box, click No.  

4 Move the stairs and railings:  

 Using a selection window, select the stairs and railings. To select only elements completely 
within the boundary of the window, drag the cursor from left to right.  

 Click Multi-Select tab  Edit panel   (Move).  

 Click the lower-left corner of the stairs as the move start point.  

 Click the lower corner of the modified floor profile as the move end point, and then press 
Esc.  

 

5 Modify the railing type:  

 Open the To Building 3D view.  

 While pressing Ctrl, select both railings (zoom in as necessary).  

 Click Modify Railings tab  Element panel  Change Element Type drop-down and select 
Railing : Guardrail - Pipe [Railing : 900mm Pipe].  

6 Add a railing to the entry deck:  

 Open the 02 Entry Level floor plan.  

 Click Home tab  Circulation panel  Railing. 
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 On the Draw panel, click  (Pick Lines). 

 On the Options Bar, for Offset enter 4'' [150 mm].  

 Zoom to the entry deck on the north side of the model.  

 Click the interior of the angled floor on the right, and then click the interior of the adjacent 
vertical floor line, as shown.  

 

 Click Create Railing Path tab  Modify, and then select the angled railing.  

 Drag the left endpoint to the right, so that the resulting railing extends just past the retaining 
wall.  

 Select the vertical railing, and drag the lower endpoint up until the resulting railing is 10' 
[3000 mm].  

 Click Create Railing Path tab  Element panel  Railing Properties.  

 In the Instance Properties dialog box, for Type, select Guardrail - Pipe [900mm Pipe], and 
click OK.  

 Click Create Railing Path tab  Railing panel  Finish Railing. Press Esc to exit the 
command. 

 

7 Add a railing on the north side of the stairs:  

 Click Home tab  Circulation panel  Railing. 

 On the Draw panel, click  (Pick Lines). 

 On the Options Bar, for Offset enter 4'' [150 mm].  
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 Click to the left of the vertical floor line above the stairs, and then click above the left north 
edge of the stairs.  

 Click Create Railing Path tab  Edit panel   (Trim).  

 Select the left side of the horizontal railing, and then select the vertical railing.  

 Click Create Railing Path tab  Railing panel  Finish Railing.  

 

8 Add a railing to the balcony:  

 Zoom to the lower-right corner of the model.  

 Click Home tab  Circulation panel  Railing. 

 On the Draw panel, click  (Pick Lines). 

 On the Options Bar, for Offset enter 4'' [150 mm].  

 Click above the south floor line, and, continuing in a counterclockwise direction, click the 
interior of the remaining two floor lines that define the balcony.  

 

 On the Create Railing Path tab, click Modify.  
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 Select the last line drawn, and drag the left endpoint to the right, just to the east of the 
exterior wall. 

 

 Select the south railing line, and drag the left endpoint to the right until it touches the exterior 
wall near the door.  

 

 Click Create Railing Path tab  Railing panel  Finish Railing.  
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9 Zoom in to the stairs, and use the same technique to add a railing below the stairs. If necessary, drag 
the right endpoint of the railing to the wall on the right.  

 

10 Open the To Building 3D view.  

11 Save the project file.  

Modifying the Roof  

In this exercise, you modify the profile of the roof in order to extend the roof over the entry deck.  

1 Open the 03 Roof floor plan.  

2 In the drawing area, select the roof.  

3 Click Modify Roofs tab  Edit panel  Edit Footprint.  

4 Modify the roof profile:  

 On the Tools toolbar, click  (Split), and split the top edge of the roof profile by 
clicking to the right of the entry deck.  

 

 On the Modify Roofs > Edit Footprint tab, click Modify.  

 Select the left segment of the split roof line, and press Delete. 

 Click Edit Footprint tab  Draw panel    (Line). Draw a line parallel to the edge of the 
entry deck. Press Esc to exit the command. 
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 Select the Roof Boundary line that was just created.  

 On the Modify Roofs > Edit Footprint tab, click    (Move). Move the line 2' [610 mm] to 
the north. 

 Select the right segment of the roof line, and drag the left endpoint to the intersection with the 
vertical floor line.  

 

 On the Draw panel, click  (Line).  

 Draw a line from the end of the right segment up to the end of the left segment.  
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 Click Modify Roofs > Edit Footprint tab  Roof panel  Finish Roof.  

5 Modify the Retaining Wall: 

 Open the 03 Roof floor plan 

 Select the 12" concrete retaining wall.  

 Click Modify Walls tab  Modify Wall panel  Attach. 

 In the Options Bar, for Attach Walls, select Top. 

 Select the roof to attach the wall to the roof. Press Esc to exit the command. 

6 Open the To Building 3D view. Right-click in the drawing area and select View Properties. In the 
Instance Properties dialog box, under Graphics, click Edit next to Graphic Display Options. In the 
Graphic Display Options, under the Background category, select Gradient Background. Select OK 
twice. 

7 Save the project file.  
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Documenting the Project  

In this exercise, you add tags to the project and schedule doors and rooms. You change an element in the 
door schedule and see that the change is automatically made in the associated plan. You also add color fill 
to rooms and modify crop regions for several views that you later add to a presentation sheet view.  

1 Create a section view:  

 Open the 02 Entry Level floor plan.  

 Click View tab  Create panel  Section.  

 Click on the left side of the model to begin the section and end it on the right side, making 
sure it cuts through the stairs.  

 

 Press Esc to exit the command. 

 Double-click the middle of the section head circle to display the section view. Alternatively, 
in the Project Browser under Views, expand Sections (Building Sections), and double-click 
Section 1.  

 

 

2 Add door and window tags:  

 Open the 02 Entry Level floor plan.  

 Click Annotate tab  Tag panel  Tag All.  

 In the Tag All Not Tagged dialog box, press Ctrl, and under Category, select Window Tags.  



Getting Started | 48 

 Click OK.  

 Open the 01 Lower Level floor plan, and use the same procedure to tag all doors and 
windows in the view.  

 

 

3 Create a door schedule:  

 Click View tab  Create panel  Schedules drop-down  Schedule/Quantities.  

 In the New Schedule dialog box, for Category, select Doors, and click OK.  

 In the Schedule Properties dialog box, for Available fields, select Family and Type, and click 
Add.  

 Add the following fields: Width, Height, and Mark.  

 Using the Move Up button, move Mark to the top of the list so that it displays first in the 
schedule.  

 Click the Sorting/Grouping tab, for Sort by, select Mark, and click OK.  

 Double-click on the right column boundary of the Family and Type column to expand it to its 
full width.  

 

4 Change a door schedule:  

 For the Mark 7 door, click the Family and Type field, and select Bifold-4 Panel : 60'' x 84'' 
[M_Bifold-4 Panel : 1525 x 2134mm].  
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 Open the 01 Lower Level floor plan. Notice that the bedroom door tagged 7 is now a bifold 
door. Changes made in the schedule are automatically synchronized in the associated plan.  

  On the Modify Doors tab, select Single-Flush: 30'' x 84'' [M_Single-Flush: 0762 x 2134mm] 
to return the door to the original family and type.  

 In the Project Browser, under Schedules/Quantities, double-click Door Schedule. The Mark 7 
door is also restored to the original type in the schedule. This bidirectional associativity in 
Autodesk Revit Architecture ensures that changes made to any part of the design are 
coordinated in all associated views, including schedules.  

5 Modify the properties of the three retaining walls to specify them as bounding elements for room 
area calculation:  

 Open the 01 Lower Level floor plan.  

 On the Modify tab, click Modify.  

 While pressing CTRL, select the three retaining walls, and click    

 Click Modify Walls tab  Element panel   (Element Properties).  

 In the Element Properties dialog box, under Constraints, select Room Bounding, and click 
OK.  

 Press Esc to deselect retaining walls. 

6 Create a Room schedule: 

 Click View tab  Create panel  Schedules drop-down  Schedules/Quantities. 

 In the New Schedule dialog box, for Category, select Rooms, and click OK.  

 Add the following fields: Number, Name, Area, and click OK. The schedule is empty but is 
updated when you add rooms and room tags to the building.  

7 Add rooms and room tags on the entry level:  

 Open the 02 Entry Level floor plan.  

 Click Home tab  Room & Area panel  Room.  

 Click to the left of the stairs to tag the large room, click in the upper room on the west side of 
the building, and then click in the small room on the west side.  

 On the Place Room tab, click Modify.  

 Double-click the tag text in the large room, change it to Entry, and press Enter.  
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 Change the tag text in room 2 to Bedroom, and the text in room 3 to Store.  

 

8 Add rooms and room tags on the lower level:  

 Open the 01 Lower Level floor plan.  

 Click Home tab  Room & Area panel  Room.  

 Beginning in the large room on the right and moving clockwise, click in each room to add the 
tags.  

 On the Place Room tab, click Modify.  

 Double-click the tag text in the large room, change it to Living Room, and then press Enter.  

 Change the tag text in room 5 to Bedroom, the text in room 6 to Bathroom, and the text in 
rooms 7 and 8 to Store.  

 

9 Open the Room Schedule view to see that it includes data for the specified fields.  

10 Define the floor in the Entry:  

 Open the 02 Entry Level floor plan.  

 Click Home tab  Area & Room panel  Room drop-down  Room Separation Line.  
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 Trace the floor line from the north wall down to and around the stairs to define the Entry 
room and create a separate floor profile for that room.  

 

 

The area for the entry room is updated in the room schedule.  

11 On the Design Bar, click Modify.  

12 Modify tags:  

 Open the 01 Lower Level floor plan.  

 Double-click the tag for one of the windows in the south wall, enter A, and press Enter.  

 In the Alert dialog box about changing a type parameter, click Yes.  

 Open the 02 Entry Level floor plan.  

 Double-click the tag for one of the windows in the west wall, enter B, and press Enter.  

 In the Alert dialog box, click Yes.  

13 Add color fill to the rooms:  

 Click Home tab  Room & Area panel  Legend.  

 In the drawing area, click to the right of the building to place the color fill legend.  

 In the Choose Space Type and Color Scheme dialog box, for Color Scheme, select Name, 
and click OK.  
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 Select the left vertical wall, and move it slightly to the left. All of the walls resize to 
accommodate the new wall dimension. The color fill in the bedroom and storage room 
readjusts and the room areas are automatically updated.  

 Open the Room Schedule view to see that the bedroom and storage room areas have changed.  

 On the Standard toolbar, click  (Undo) to restore the wall to its original dimension.  

 Reopen the 02 Entry Level floor plan and verify the wall has changed.  

14 Open the 01 Lower Level floor plan and repeat the previous procedure in that view.  

 

15 Modify a crop region to create a view for a sheet:  

 Open the 01 Lower Level floor plan.  

 On the View Control Bar, click Show Crop Region.  

 Enter ZF to zoom to fit the entire view in the drawing window.  

 Select the crop region, and drag the triangular blue controls to shrink the region around the 
model.  

 

 On the View Control Bar, click Hide Crop Region.  

16 Using the same method, modify the following views:  

 02 Entry Level floor plan  

 East elevation view  

 North elevation view  
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Creating a Solar Study  

In this exercise, you create an animation of the solar activity at a particular place and time in order to 
study the light and shadows that affect the building site.  

1 Open the To Building 3D view.  

2 On the View Control Bar, click Shadows  Graphic Display Options.  

3 In the Graphic Display Options dialog box:  

 Under Shadow, verify that Cast Shadows is selected.  

 Under Sun, click  

4 In the Sun and Shadows Settings dialog box, click the Single-Day tab.  

5 On the Single-Day tab, select any one of the solar studies in the list, and click Rename.  

6 In the Rename dialog box, for New, enter One Day Solar Study - Your Location - Summer Solstice  

(Winter Solstice if you are in the southern hemisphere), and click OK.  

7 In the Sun and Shadows Settings dialog box:  

 Under Settings, for Place, click , select a city near your location, and click OK.  

 For Date, enter Today.  

 For Time Interval, select 15 minutes.  

 Clear Ground Plane at Level so that the shadows fall on the terrain.  

 Click Apply, and then click OK.  

8 In the Graphics Display Options dialog box, click Apply, and then click OK.  

9 On the View Control Bar, click Shadows On  Preview Solar Study.  

10 On the Options Bar, click  (Play). The solar study animation is displayed, showing the 
progression at 15-minute intervals for the location and date specified.  

11 Export the animation:  

 Click   Export  Images and Animations  Solar Study.  

 In the Length/Format dialog box, changes Frames/sec to 1 and click OK.  

 In the Export Animated Solar Study dialog box, click the Desktop icon, and click Save.  

 In the Video Compression dialog box, for Compressor, select Full Frames (Uncompressed), 
and click OK. The animation is played again as the AVI file is saved to your desktop.  
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 On your desktop, double-clicking on the AVI file displays the animation. Move the scroll bar 
to change the time.  

Creating a Sheet  

In this exercise, you add multiple views to a sheet. You also change the roof slope parameter to test the 
parametric capabilities of Autodesk Revit Architecture. The walls that are attached to the roof are updated 
to maintain constraints with the modified roof.  

1 Create a sheet:  

 In the Project Browser, right-click Sheets (all), and click New Sheet.  

 In the Select a Titleblock dialog box, click OK.  

 In the Project Browser, expand Sheets (all), right-click A101 - Unnamed, and click Rename.  

 In the Sheet Title dialog box, for Name, enter Presentation, and click OK.  

2 Drag the 01 Lower Level floor plan from the Project Browser onto the upper-left corner of the 
sheet, and click to place it.  

3 Add the following views to the sheet:  

 02 Entry Level floor plan  

 Section 1  

 East elevation  

 North elevation  

 Door Schedule  

 Room Schedule  
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If a view is too large to fit on the sheet, place it in the drawing, right-click, and click Activate 
View. Right-click again, select View Properties, and in the Element Properties dialog box, for 
View Scale, select a different scale. Click OK, right-click the view again, select Deactivate 
View, and reposition it on the sheet.  

4 Modify the roof slope:  

 In the drawing area, right-click the East elevation view, and click Activate View.  

 Select the roof.  

 Click Modify Roofs tab  Element panel   (Element Properties).  

 In the Element Properties dialog box, under Dimensions, for Slope, enter 4''/12" [15°], and 
click OK. In all views, the walls and curtain walls that attach to the roof are extended and 
maintain the connection to the modified roof.  

 Change the slope parameter back to 1'' [5°]. The walls and curtain walls are updated with the 
roof.  

 In the East elevation view, double-click the height value for the 03 Roof Level, and enter a 
new value. In all views, the walls and curtain walls that attach to the roof maintain the 
connection to the modified roof.  

 Right-click, and click Deactivate View.  

Any modification to the model is updated in the project drawings so that they are always 
coordinated. Try deleting or moving interior walls and doors; the changes will be made in all 
drawing views and schedules.  

GBXML Export 
In this exercise you will export the model to the gbXML format for use in analytical programs such as 
Autodesk® Ecotect® Analysis 2010 software. 

1 Open Section 1 view. 

2 Change Visibility/Graphics: 

 Enter VG for the Visibility/Graphics Overrides for Section: Section 1dialog box. 

 In the Visibility/Graphics dialog box, expand the Rooms category in the Visibility column, 
select Interior Fill and click OK. Notice that the blue fill representing the Room volume does 
not extend beyond the 03 Roof level.  

3 Change the Room offset: 

 Open 02 Entry Level 
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 Press and hold Ctrl and select the Room Element in the Entry, Bedroom, and Store areas, by 
selecting the “x” in each space as shown in the image below: 

 

 Click Multi-Select tab  Element panel    (Element Properties). 

 In the Instance Properties dialog box, set Limit Offset to 14'. The entire Room must extend 
beyond the roof. 

 Open Section 1 view to verify Room extends beyond the roof. 

4 Delete Area Separation Line: 

 Open 02 Entry Level floor plan. 

 Press and hold Ctrl to select 4 Area Separation Lines created in a previous exercise. 

 

 Click Modify <Room Separation> tab  Modify panel   (Delete). 

5 Manage Area and Volume Settings 

 Click Home tab  Room & Area panel drop-launcher arrow  Area and Volume 
Computations. 

 In the Area and Volume Computations dialog box select Areas and Volumes and select At 
wall center. 

6 Export to gbXML: 

 Open To Building 3D View. 
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 Click   Export  gbXML 

 In the Export gbXML dialog box, change Building Type to Single Family.  

 Enter the Postal Code for your location. 

  

 Use the View Cube in the viewing window to navigate around the model and identify that all 
interior spaces are represented with a blue volume. 

 Click Export to create the gbXML file. By default, the XML file name takes on the same 
name as the RVT file in the same directory location. Click Save to create the XML file. 

 Save the RVT file when done. 

 This is the completion of this Getting Started tutorial. 
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Appendix 

Autodesk® Revit® Architecture 2010 

Mouse Interface and Keyboard Shortcuts

 

Mouse Interface 
Select Element = Left Click 
Pop-Up Menu = Right Click 
Zoom In = Scroll-Wheel forward 
Zoom Out = Scroll-Wheel backward 
Pan = Hold Scroll-Wheel Down and Drag  
Rotate View in 3D = 
Shift Key + Scroll-Wheel Down + Drag 
 
 
View Control 
HL  Hidden Line 
SD  Shading with Edges 
VG  Visibility / Graphics 
VP  View Properties 
WF  Wire Frame 
ZA  Zoom All to Fit 
ZC  Previous Scroll Zoom 
ZX  Zoom to Fit 
ZV  Zoom Out (2x) 
ZZ  Zoom in Region 
F5  Refresh Window 
 
 
Snap Overrides 
SE  Endpoint 
SC  Center 
SH  Horizontal / Vertical 
SI  Intersection 
SM  Midpoint 
SN  Nearest 
SO  Snaps Off 
SP  Perpendicular 
SQ  Quadrants 
SR  Snap To Remote 
SS  Standard Snapping 
ST  Tangent 
SW  Work Plane Grid 
 
 

Edit 
AR  Array 
CO  Copy 
DE  Delete 
GP  Group 
LO  Lock Objects 
MD  Modify 
MM  Mirror 
MV  Move 
PR  Properties 
RO  Rotate 
 
Modeling 
WA  Wall 
WN  Window 
DR  Door 
CM  Component 
LI  Modeling Lines 
 
Drafting 
DI  Dimension 
DL  Detail Lines 
EL  Spot Elevation 
GR  Grid 
LL  Level 
RP  Reference Plane 
RT  Room Tag 
TX  Text 
TG  Tag 
 
Tools 
AL  Align 
LW  Linework 
OF  Offset 
PT  Paint 
SF  Split Face 
SL  Split Walls and Lines 
TR  Trim and Extend
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